
  CONDES instructions Nov 09 

  CONDES version 8.1.20 

1 

CONDES 8 INSTRUCTIONS 
 

One way of using the program is to follow the following sequence: 

create a file for the event 

put the circles for all of the event’s controls onto the map 

enter the descriptions for those controls 

build up the course from the collection of controls. 

 

Creating a New File for a New Event 
If you have already used the software for a previous event, select the ‘New event 

file’ item in the File menu.  If this is the first time you have used the software, you 

will come into the ‘Event Wizard’ automatically. 

A series of ‘Event Wizard’ windows will appear, leading you through the process of 

setting up a new event. The first 4 pages will be self-explanatory. 

The fifth page allows you to choose how many map files you are using: 

 

 

Usually you will choose the first option; if you have a map at two scales where the 

two versions are different OCAD files (e.g. Ainsdale at 1:10 000 and 1:7 500) 

choose the 3rd option (‘One map: Two scales, two map files’). The 2nd option is 

only used if you have only one map file, but intend to print some courses at a 

larger scale – even though the enlarged print will still have the original scale 

printed on it. The 4th option (‘Two maps: Two map files’) would be used if a course 

ran from one area to another e.g. if using both the Ainsdale and the Birkdale maps 

in the same event. 

The sixth page requires you to specify your map file(s). Use the dialog to select the 

type of map file (usually OCAD), then select the map itself by selecting the file 

name from the File dialog box which appears. Note that the ‘Printout scale(s)’ 

should be the same as the map scale, and as used for the event – your choice at 

this point doesn't stop you from e.g. later printing the ‘all controls’ map at a larger 

scale. 
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If you are using two map scales, the seventh page is this one: 

 

 

 

Choose the second option, so that you can cut gaps in the circles in different places 

for the two different scales. 

This will eventually lead you into the ‘Course Layout editor’ canvas, which you will 

use for putting in the controls. Before doing that, it is a good idea to save the file. 

Your file name could include the event date in the format 12 Oct 07 but not 

12/10/07. 
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Creating the All Controls Map 
All of this is done in the ‘Course layout editor’ window, with the 'All Controls' map 

open. This will probably have appeared automatically; if not, click on ‘Controls’ at 

the bottom left of the Course Layout Editor canvas. 

There are four ways of moving the map around the screen: 

mouse wheel (up/down only; click in map to select it first) 

scroll bars and their nudge arrows 

click on the ‘select course object’ icon (LH icon on the Course Layout Editor 

canvas toolbar), then put the cursor on the map and hold down the LH 

mouse button: you can then drag the map around 

put the cursor on the map and hold down the right mouse button: the cursor 

changes into a hand, and you can drag the map around. 

The third method is the most useful, but be careful not to accidentally select and 

move one of the overprint bits as you are doing it. 

You can also change the magnification of the map, using either the Zoom box or 

the Zoom in / Zoom out icons on the toolbar. 

 

 
The Zoom in tool allows you to draw a box around the section of map which you 

want to magnify (put the cursor on the map, hold down the left mouse button and 

drag to create the box). 

1) Start: 

click on the ‘New start’ icon (RH toolbar, 2nd from top) 

click on the map where you want the start triangle to be centred.  Magnify the map 

so that you can be precise in your positioning. 

A ‘New start point’ window will appear: if you have only one start then you can 

leave the code as S; for more than one start, S1 etc. 

The program will then automatically move on to the finish; if you have more than 

one start, click on the ‘New start’ icon again then put in your next start. 

2) Finish: 

the program will probably have automatically moved on to the finish, in which case 

the cursor will appear as a cross with a double circle alongside; if not, then click on 

the ‘New finish’ icon (RH toolbar, 3rd from top).  

Click on the map where you want the finish circles to be centred.  Cancel the ‘New 

course’ window which then appears. 

3) Controls: 

It is easiest to put these on in order of their codes, starting with the lowest (if you 

do not know the final code yet, it does not matter: the code can be altered later). 

Click on the ‘New control’ icon (RH toolbar, top). 

Click on the map where you want the centre of the circle to be. 

In the ‘New control’ window which appears, enter the code. 

Continue for all of the controls. 

If you want to go back to adjust the position of a circle, click on the ‘Select object’ 

icon (Course Layout Editor canvas toolbar, top, LH side), select the circle and drag 

it to the right place. 
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If one of the controls is to be a map exchange (or 2nd master maps), select the 

control then right click within its circle.  From the menu which appears, select 

Edit control... 

In the new window which appears, make sure that the Control description tab is 

selected then change the control’s type to Normal / Map Change (if the exchange 

takes place at the control) or Normal / Marking to map change (if the 2nd part is to 

start elsewhere; you will then need to put a start triangle at this new point).   

Note that all courses using this control will now have it as a map exchange. 

For other ways of dealing with a map exchange, see Map Exchanges and 2MM 

below. 

 

Once you have entered the controls, lock their positions so that you do not 

accidentally move one whilst entering the courses: 

Course layout 

Lock control locations  

(or use key button on top toolbar). 

Working with two map files at different scales: 

Enter the control collection on the smaller-scale map i.e. the one which covers the 

entire area (if both maps cover the same area, then you can use either). 

To switch to the view of the other map: from the Course Layout Editor canvas, top 

menu bar, LH side: where it says ‘canvas’, click on the arrow to open the list of 

available maps, then select the one you want. 

 

4) Descriptions: 

[For details of what goes in which column of a pictorial description sheet, see 

Appendix 1 at the end of these instructions] 

The Course Layout Editor window now has a list of control codes down its LH side. 
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Double click on the first one: the control editing window opens. Click in a box of the 

description and select a symbol from the window on the right – for each box you 

will be shown the appropriate standard IOF options, i.e. which of several, feature, 

size, position, etc (for details of what goes in which column of a pictorial description 

sheet, see Appendix 1). Click the appropriate item(s) and then OK.  

 

The buttons under right-hand window allow additional options such as putting two 

features in a box, entering a size (the 3x5 button), and deleting what you have 

entered. 

To enter a size, select the appropriate box then click on the ‘3x5’ button in the 

control window; the dimension is typed into the text box which appears above that 

button. 

 

 
 

 

If you have entered a description into a box and then want to revert to a blank for 

that box, select the box then clear it using either the red � button in the control 

window or the delete key on your keyboard. 

 

CONDES can automatically generate text descriptions from the pictorial symbols 

you have entered. If you want to use only your own custom descriptions rather 

than the standard translation (e.g. if you want to say "small hill" rather than "knoll" 

for young beginners), you don't need to enter any pictorial symbols. Instead, click 
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the 'Texts, Score-O and Status' tab on the bottom and select the option 'Use my 

manually entered text', then type the description in the text box. 
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Entering a Course 
From the menu bar of the main window: 

Course 

New 

(or click on the ‘New course’ button on the top toolbar) 

Enter the course name (e.g. white) 

OK 

From the canvas top toolbar, click on ‘Insert control’ (3rd button from left).  This 

will display all the event’s controls on the map.  You then click on the appropriate 

controls on the map in order to build up your course. 

Don't worry about bending lines or cutting circles at this stage. 

If you enter a wrong control, leave it in and keep going – it’s easiest to remove it 

after putting in the rest of the course (see next section). 

When you have finished: 

press ‘escape’ 

or 

right click 

Edit course... 

OK 

or 

right click 

New course... 

and start on the next course. 

 

Map Exchanges and 2MM 
If the map exchange / 2MM applies to all courses using the control, then the 

procedure given in Creating the All Controls Map: 3) Controls is fine. 

If the control is also used by courses not using the map exchange / 2MM, life is 

more complicated.  Choices are as follows: 

1) Map exchange at control 

Define the control type as Normal/Map Change' 

All courses using the control will then offer parts 1 and 2 at the ‘export courses to 

OCAD’ stage.  For those courses requiring the map exchange, select parts 1 and 2 

separately; for the other courses, select just the course – don’t open up the ‘+’ 

box. 

2) Map exchange away from control: amending an existing course 

Insert an ‘end of marked route’ (RH toolbar, 4th from top) on the ‘All controls’ map 

at the site of the map exchange (i.e. at the position of the new start). Insert a new 

start (RH toolbar, 2nd from top) at the same place. In the Edit Course dialog, insert 

both into the course as in Adding or Removing Controls from Courses. 

Note that the new start triangle will not appear on the first part map – the marked 

route will finish “blind”. 

3) Map exchange away from control: inserting the new start triangle as the 

course is built up 

Build the course including the second start triangle (at the start of the second part) 

as you go along. 

Insert an ‘end of marked route’ at the second start point. 

This will not appear on courses using the control but not going to the map 

exchange. 



  CONDES instructions Nov 09 

  CONDES version 8.1.20 

8 

Adding or Removing Controls from Courses 
At the bottom left of the Course Layout Editor canvas, click 'Edit Courses', then 

select the appropriate course from the list on the left hand side of the screen. 

Right click anywhere on the map.  From the new menu which appears, select 

Edit course... 

To delete a control, select it here  

 
then click the red � button or press ‘delete’ on the keyboard. 

 

Alternatively, to add a control, select its number in the list of available controls 

which is here  

select the control which is to come after the new control, here  

and click the 'Insert control' button. 
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Analysing the Courses 

1) Attack Angles 

To check on the directions of approach and 

departure for individual controls: in Course 

Layout Editor, with either the all controls 

map or an individual course map: 

click on the ‘Select Course Object’ 

icon (canvas top toolbar, LH icon) 

select the control circle 

right-click 

From the new menu: 

Control circle... 

From the new window, select ‘Attack angles’. 

The red lines indicate directions of approach, 

the blue directions of departure. 

 

2) Control Analysis 

View 

Controls spreadsheet 

 
Does not allow data to be entered or amended. 

Can be exported (minus the descriptions) to e.g. a spreadsheet: click on 'copy to 

clipboard' just below the tabs at the top of the window, then paste it into the other 

program. 

Right hand columns may initially be very narrow: to widen them so that you can 

read them, move the cursor onto the line in the column heading and then drag it to 

the right. 
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Alternatively: 

Control 

Control/course diagram 

gives you this sort of table: 

 
 

This one also does not allow data to be entered or amended; neither can it be 

exported. 
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3) Course Analysis 

View 

Courses spreadsheet 

 
 

Except for the controls column, data can be entered or amended: double click in a 

box to select it, then type the information. 

New courses can be entered, but it is better to use the method in ‘Entering a 

Course’ above. 

Can be exported to e.g. a spreadsheet by clicking on 'copy to clipboard'. 

 

4) Class Analysis 

View 

Classes spreadsheet 

 
New classes can be entered by clicking on 'New…' 

You can insert class names and estimated competitor numbers by double clicking in 

the appropriate cells; single-clicking in the 'Course' and 'Control description' 

columns provides drop-down lists. 

Can be exported to e.g. a spreadsheet by clicking on 'copy to clipboard'. 
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Editing Overprints 
Beware: any cutting or bending of lines to/from a control will be lost if you 

subsequently change the code of the control, so only start on this work once you 

know your final control codes. 

 

Select the appropriate course in the ‘Course layout editor’ canvas. 

1) Moving lines: 

click on ‘Add point’ (course layout editor toolbar, 4th from left) 

click on the line twice – once to select it, the second time to insert the point 

click on ‘Select course object’ (course layout editor toolbar, LH button) 

drag the point just added to where you want it. 

Note that this bend will appear in every course that uses this same leg.  If you do 

not want this to happen: 

select the line 

right click on the line 

Properties... 

and select ‘Specific for this course’. 

2) Cutting lines: 

click on ‘Select course object’ (course layout editor toolbar, LH button) 

click on ‘Cut line’ (same toolbar, scissors icon) 

click on the line twice – once to select it, the second time to insert the gap 

click on ‘Select course object’ again 

drag the two points either side of the cut (which is now shown in grey) to 

adjust the length of section removed. 

Note that this cut will appear in every course that uses this same leg.  This can be 

changed by the same method as in moving lines (above). 

3) To insert a taped route from one control to another: 

click on ‘Select course object’ 

right click on the line 

Properties... 

select “Follow taped route between controls”. 

The line of the route can be altered as in 1) above. 

4) To insert a taped route away from a control part of the way to the next 

control: 

click on the ‘New end of marked route’ button (RH toolbar, 4th down). This 

will automatically open the ‘all controls’ map 

click on the map where you want the route to end; in the window which 

comes up, give the route a code. 

Return to the course by selecting it in the 'Course layout editor' canvas; right click 

anywhere in the window and from the menu which comes up select: 

Edit course... 

select the taped route number in the list of available controls  

select the control which is to come after the taped route 

then click on the ‘Insert control’ (O� ) button. 
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5) To cut a circle: 

Ensure that “Print scale” (in the information bar at the bottom of the course layout 

editor window) is set to the correct value when doing this – circles will always come 

out with a 6�0mm diameter, irrespective of the map scale; if the print scale is set 

wrongly, then the circle will be centred 

correctly on your screen but the circle will be 

a different size to the printed version. Also, 

when cutting circles, you need to use a 

course map, not the all controls map – the 

all controls map uses smaller circles. 

click on ‘Select course object’ 

click on the circle to select it 

right click inside the circle 

select ‘Control circle...’ 

click on the circle within the new 

window to remove or replace 

sections of the circle. 

 

6) To move a control number or a circle: 

As with 5) above, ensure that the print scale is set correctly first. 

click on ‘Select course object’ 

click on the circle to select it 

to move the number: 

move the cursor to the number and drag it to where you want it; 

to move the circle: 

right click inside the circle 

select ‘Control circle...’ 

select ‘temporarily unlock’ (if your control circles are locked) 

use the arrows to adjust the circle position 

OK 

Note that moving the circle will move it in all courses using that control; moving its 

number will affect that course only. 

7) To add a crossing point symbol: 

click on the ‘New mandatory crossing’  button (RH toolbar, lower part) 

click on the map where you want the crossing point; in the window which 

comes up, give the point a code 

click on the ‘Rotate’ button (course layout editor canvas top toolbar, 2nd 

from right) 

click on the crossing point to select it 

click again, holding down the button while rotating the crossing point 

Escape 

Right click anywhere on the map; from the menu which comes up select: 

Edit course... 

select the crossing point number in the list of available controls  

select the control which is to come after the crossing point 

then click on the ‘O� (Insert control)’ button. 

8) To add out of bounds areas, refreshment points, uncrossable boundary 

lines and forbidden route symbols: 

use the buttons in the RH toolbar. 

Note that you cannot rotate the forbidden route symbol. 
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9) To select a different start or finish: 

right click anywhere on the map 

from the menu which comes up select: 

Edit course... 

select the appropriate start or finish from the drop-down lists in the 

Start/finish box on the left hand side of the dialog box. 

 



  CONDES instructions Nov 09 

  CONDES version 8.1.20 

15 

Altering Control Codes 
In Course Layout Editor (either ‘All Controls’ or any course), click on the circle of 

the control to select it; then right click. 

From the new window: 

Edit control... 

In the new window, amend the code in the box above the description line. 

(The program will not allow you to use a code which is already in use.) 

Make sure that ‘Rename and substitute’ is selected in the ‘Substitute control code’ 

window which then opens, otherwise the courses will not be altered. 

Beware: any bending or cutting of lines will be lost at this point – lines will revert to 

being straight and continuous. 

Description Sheets 
To view the description sheet, have the appropriate course map in the course 

layout editor canvas, then from the top menu select: 

Course 

View Control Description 

(or click on the Preview control description icon in the top toolbar). 

1) To insert the amount of climb: 

Select the appropriate course in the ‘Course layout editor’ canvas. 

right click on the course 

Edit course... 

In the 'Header fields' section on the left-hand side there is a box for you to type in 

the climb. 

2) To instruct competitors to use a particular crossing point: 

Include the crossing point in the ‘All controls’ collection and in the course (see 7) 

under Editing Overprints above). The instruction will automatically appear as 

symbols in the description sheet.  If you want the instruction to appear as words as 

well, use the method given in 3) below.  If you want the instruction in words ONLY, 

you can do this by deleting the symbol line in OCAD; however, this will only affect 

the overprint – the separate description sheets cannot be altered. 

3) To add a comment or instruction to a particular control: 

With either the ‘All controls’ map or the relevant course: 

click on the control circle to select it 

right click  

select Edit control... 

select the ‘Texts, Score-O and Status’ tab and type the text in the 'Additional text' 

box.  

The text will then appear in the description sheet for every course using that 

control.   
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4) To add a course closure time: 

As 3) above; add the comment to the finish circle. 

5) To set text descriptions for a particular course: 

With the appropriate course on the Course layout editor canvas, right-click within 

the map. From the new menu, select 

Edit Course... 

In the 'Control desc. appearance' section on the left hand side, select 'Textual'. 

Although CONDES will automatically generate text descriptions from the IOF 

symbols (if you have used them rather than your own text), these will need 

checking for translations such as "Knoll hill between". Also the lines for the route to 

the finish and any crossing points will not be translated. So: 

View the description sheet by having the appropriate course map in the 

course layout editor canvas, then from the top menu selecting 

Course 

View Control Description 

(or by clicking on the Preview control description icon in the top tool bar). 

Read through the sheet and decide which lines need amending. 

On the course map, select the relevant control / crossing point / taped route, 

then right-click. From the new menu, select 

Edit control... 

In the new ‘Control’ window, select the ‘Texts, Score-O, and Status' tab 

(bottom, middle), then select the 'Use my manually entered text' button 

Now type your description in the box. 

Note that these descriptions will then appear on every course using those controls / 

crossing points / taped routes and using textual descriptions. 
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6) To include the description sheet in the overprint: 

from the RH toolbar of the course layout editor canvas: click on the ‘New control 

description’ icon (5th from top), then click on the map roughly where you want the 

top left-hand corner of the description sheet to be. 

The ‘Control description properties’ dialog box opens.  

 
 

On the 'Main' tab you can select whether the descriptions should appear in this 

location for all courses or for this course only. If you select this course only, the 

'What' tab offers the option of showing the whole or part of the course (used if e.g. 

you split the course into two parts on separate maps); if you select all courses, the 

'What' tab offers no options. 

The 'Appearance' and 'Fonts' tabs offer further options. 

Size: IOF specifies 5-7 mm (the program will allow other sizes, but only 

integers) 

Appearance: leave 'The relevant class or course decides' selected, as you 

have already specified this in the 'Edit course' dialog. This is also where 

you select the colour of the description sheet on the map. 

To adjust the position of the description sheet: in ‘Course layout editor’: 

reduce the zoom until you can see the whole map 

left click within the description sheet to select it 

drag the sheet to where you want it. 

If you want to alter the description sheet later, click on it to select it; right click; 

Properties 

re-opens the Control descriptions properties window. 

 

The description sheet can cover part of the map – it blanks out the section of map 

below it – but if you do this, beware: if you subsequently import the course into the 

OCAD map file (rather than opening the map as a template in the course file), you 

will not be able to select the description sheet to adjust it. 
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[Note that after using  

Course layout > Show/hide print area 

the green rectangle around the map shows the area selected within CONDES for 

printing. To alter it, first left-click on the green line; you can then drag the 

rectangle to different positions, or change its size by dragging any of the black 

squares which can be seen whilst it is selected. Also visible whilst the green box is 

selected will be one or more purple boxes, representing the printer’s page size – 

this will be controlled by the printer driver. If the green box is bigger than the 

purple one, the map will be spread across more than one page.  Right-clicking 

within the green box when it is selected opens a menu allowing various sizes and 

orientations of print area to be selected. You can change from portrait to landscape 

through: 

File > Print Setup... ] 

 

7) If not having the description sheet as part of the overprint: 

You will want the overprint to include a course label, preferably in a corner (it's 

easier to check there). Click the 'New text' icon (6th from the top on the right-hand 

toolbar), and click on the map where you want the text to appear. The 'Text' dialog 

box appears, which offers various options: e.g. you can select 'All courses' and 

'Standard text' and tick 'Course name', to make the course name appear in that 

location on all maps. If you then want to move or edit it, click 'Select graphics 

object' (2nd from left on the Course Layout editor toolbar) and select the text. 

8) Printing separate description sheets: 

from the toolbar of the main window: 

Print 

Control descriptions 

Selecting ‘Courses’ will give one copy of each course. 

Selecting one particular course will fill a sheet with multiple copies of that course. 

Adjusting the box size at this point affects the separate descriptions only, not the 

description sheet on the map. 

(You can also click the 'Preview control descriptions' icon on the top toolbar for any 

course and then copy (use Edit > Copy, or Ctrl + C) and paste the descriptions into 

Word etc.) 
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Exporting the Course Data to Event Administration Software 
The course data will be needed to set up the event in OE2003/Autodownload. 

Export 

Export event data 

IOF XML format… 
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Exporting the Courses to OCAD 
This is normally the last stage before printing the maps. 

Start by creating a new folder into which to save the OCAD files when you create 

them. 

Next, the courses each need to be saved as separate OCAD files: 

 

from the toolbar of the main window in CONDES: 

Export 

Export courses to OCAD... 

Putting a tick in the ‘Courses’ box will export each course as a separate OCAD file 

(courses with a map exchange will have a file for each part). 

To get just one course, remove the tick from ‘Courses’ and select just the course 

you want (if there is a map exchange, you will need to click on the + and then 

select both sections separately). 

Ticking the ‘All controls’ box gives a map showing all of the event’s controls. 

Then click on the Export button. This will then open up the usual Windows 'Save as' 

window which will allow you to select the folder into which to save them; keep 

clicking 'Save' until all courses have been done. 

 

In OCAD: 

1) open the course 

2) open the map as a template 

You can make any final adjustments to the course and the descriptions – if included 

– at this stage. The map file is now a template and cannot be edited, but any 

corrections made previously will show as long as they are saved in the map file 

which is associated with the CONDES file. 

Any description sheet on the map will now be in black, even if you chose to have it 

in purple when working in CONDES. This is because it is saved as colour "CD line" 

in OCAD, which is defined as being black. If you want to get back to a purple 

description sheet, redefine the colour in OCAD as 100% magenta, 0% the others. 

 

Note that if you send the CONDES file to anyone else (controller, the person doing 

the printing for you), you will also have to send the map file you used so that they 

can open it as a template. 

 

(It is also possible to open the map and then open the course as a template, but 

then you can't edit the overprint or descriptions, if they are included in the 

overprint, and you could accidentally alter the map for one course but not the 

others.) 
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Appendix: Control Description Layout 
The following is taken from the IOF’s “International Specification for Control 

Descriptions” (2004), which also gives the definitions of all the symbols.  It can be 

found at http://www.orienteering.org/ – go to Document library, then Rules and 

Guidelines; the pictorial descriptions are under Foot-O rules. 

 

Explanation of Columns 
Each control is described in the following manner: 

Column A - Control number 

Numbering of controls is in the sequence they are to be visited, unless the 

description is for a Score competition. 

Column B - Control code 

The control code should be a number greater than 30. 

Column C - Which of any similar feature 

This column is used when there is more than one similar feature within the 

control circle; e.g. south eastern. 

Column D - Control feature 

The feature, as shown on the map, at the centre of the circle defining the 

control site; e.g. clearing; boulder. The description of each control is based on 

the International Specification for Orienteering Maps (ISOM 2000). 

Column E - Appearance 

Further information on the nature of the feature if it is required; e.g. 

overgrown; ruined.  In certain circumstances also used for a second control 

feature where the description requires this. 

Column F - Dimensions / Combinations 

Dimensions of the feature should be given where the size of the control 

feature on the map is symbolic rather than to scale. 

Also used for the two combination symbols (crossing; junction). 

Column G - Location of the control flag 

Position of the control flag with respect to the feature; e.g. west corner 

(outside); south foot. 

Column H - Other information 

Other information that may be of importance to the competitor; e.g. radio 

control; refreshments. 

 

 

 

Notes: 

 

1) one symbol covers all three types of path (indistinct, minor and major) as well 

as track. 

2) For junctions and crossings, the features go in columns D and E with the junction 

(or crossing) symbol in column F. 

e.g. a path crossing would read ‘path path crossing’. 

3) When the control is between two features, the features again go into columns D 

and E, the ‘between’ symbol goes into column. 


